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The Ultimate Guide �for �New Employees �





Your first days at ILINC

�Welcome to ILINC 

Insert Letter from Jim O.�

First Day Activities Checklist

Use the checklist below to make sure you’re getting the full ILINC experience! 



q	Meet with your supervisor.

q	Meet with Human Resources/Office Manager. Fill out employment & healthcare forms.

q	Tour of the company offices.

q	Meet with a member of the Executive Team.

q 	Watch company videos: LearnLinc promotion video, customer interviews, and 	LearnLinc in action.

q 	Have lunch with your new co-workers. New guy buys! (OK, OK, just kidding!)

q 	Participate in a LearnLinc demonstration and technology discussion.

q 	Get an industry and competitors overview.

q 	Set up your office space, voice mail, computer, and pictures of your family.

q  	Review the following sections in this Guide:

New Employees’ Frequently Asked Questions (FAQ)

Company policies

Internal Communications Guidelines

Organization Chart

Office tour (a beautifully detailed map on paper)

Settling in 

Introduction to the Network

Company directory

Using IILINC’s Phone System

�New Employees’ Frequently Asked Questions 

(or at least the ones we think you’ll ask)�

The Top 10 Non-Technical Questions Asked by �New Employees

1. 	When do I get my first paycheck?

ILINC paydays are the 15th and the last day of each month. If payday falls on a weekend or holiday, employees are paid the last business day of that week. On payday, a member of the administrative staff will personally hand you your paycheck, usually around lunch time. And there is much rejoicing.  

If you are a salaried employee, you will get your first paycheck on the first payday after you begin working for ILINC. Salaried employees are paid current, there is no “backpay” collected your first two weeks with ILINC.

Hourly employees are paid on a slightly different schedule. They are paid in two week (80 hour) increments, for a period of time prior to payday. For more information about the pay schedule for hourly employees, read your ILINC Employee Handbook, or have your supervisor explain it.

2. 	How long do I get for lunch?

When you take lunch and how long you can take is at your supervisor’s discretion. It also depends on whether or not there is someone to cover for you while you’re out. Generally, people take about an hour for lunch.

3. 	Where do I pick up/send out my regular “snail” mail? 

Employee mail boxes are located on the bookcase in the reception area. Each person has his/her own mail slot. 

You can use the postage meter in the faxing/photocopying area to apply postage to outgoing mail. To use the postage meter, make sure the dollar amount and date are correct, then run your letter through the machine. If they date and time are incorrect, ask the Receptionist or Office Manager for help. Put your outgoing mail in the bin between the bookcase and the Receptionist’s desk.

4. 	Where should I park my car?

As close to the door as possible, of course. It is rarely difficult to find a parking spot at the ILINC office. Most people who work in the front of the building park in the front, and most who work in the back park in the back. Your office key works in either door. If we are expecting a large group of visitors, you may need to park around the side of the building or further away.

�5.	Is it safe to leave my car in the lot while I’m out of town on business?

Generally speaking, yes. Of course, lock your doors and put anything of value in the trunk. If you are going to be gone for more than a week or two, you may want to make arrangements to park your wheels at home. ILINC assumes no responsibility for any damages to your vehicle or other personal property.

6. 	Is it safe to leave personal belongings in my work area?

Generally speaking, yes. Be advised, however, that people other than ILINC employees are regularly in the office. Confidential or personal information may be stored in a locked filing cabinet, desk drawer, or at home.

7. 	I’m having a nicotine fit, but so far I haven’t seen any other smokers. Where are 	they hiding?

There are industrial-size ashtrays provided for smokers near the front and back exits of the building. If you are looking for company, you are most likely to find someone at the back of the building.

8. 	How far in advance must I request vacation time?

It is best to request vacation time 30 days in advance. This ensures adequate coverage while you’re gone. This also guarantees that you endure at least 20 agonizingly long days of work before finally escaping to that magical land of vacation. 

In some situations, your supervisor may approve vacation days on shorter notice. It depends on your individual workload and the collective activities of the company for the day(s) you are requesting. The ILINC Employee Handbook further discusses vacation time, how you accrue it, and much much more.

9. 	Who do I ask to approve my vacation time?

Your supervisor approves requests for vacation. It is usually sufficient to e-mail him/her the dates you are requesting off. Then he or she will approve your request or work out any conflicts with you. Once your vacation time is approved, e-mail the Office Manager the dates that you will be out.

�10. 	Who is the ILINC Board of Directors and what do they do?

The ILINC Board of Directors meets quarterly to formulate policies regarding the functioning of the company, determine its strategic direction, and evaluate current management practices.

Official Board Members

Jack Wilson, Chairman of ILINC and Dean of Continuing and Undergraduate Education at RPI

Jim O’Keefe, President and CEO of ILINC 

Mark Bernstein, Executive Vice President, ILINC 

Degerhan Usluel, Vice President of Development, ILINC

Mike Marvin, CEO of MapInfo Corporation

Steve Clearman, GeoCapital Investment Firm

Board Advisors

Mark Rice, Assistant to the Dean of Continuing and Undergraduate Education at RPI

Roland Schmitt, Former President of RPI and Vice President of General Electric

�Top 10 Technical Questions Asked by New Employees

1. 	I’ve never seen a fax machine as ancient as yours… How does it work?

Although our fax is big and bulky, it is dependable and easy to use. Here’s how:

Place your cover sheet and document in the tray face down. About 1-2 inches of the pages should be in the machine. 

When the digital display prompts you to enter the destination telephone number, go ahead and do it. (It is not necessary to dial “9” when faxing- it is a separate phone line. However, you must enter �1 +area code if faxing outside the 518 area code.) You should hear the fax on the other end ringing, similar to a telephone. 

When you here a steady tone, press the big green button labeled “Start.” The fax machine will automatically suck in one page at a time (and spit them out to the left) until they have all been sent. Occasionally, the fax will suck in more than one page at a time, resulting in a missing page on the other end. Check to make sure each page was faxed by looking for a light pink dot at the bottom of the pages. Missing dot equals missing page. 

If you dial a wrong number or get a busy signal, withdraw your documents and press the orange “Reset” button to start over.

Never, ever play tug-of-war with the fax machine. That is, don’t try to pull out pages that the machine is trying to suck in. You may win, but will probably break it. That’s not a good thing.

Always, always fill the paper tray when you notice that it’s empty. It is terrible to miss a big order or important message for the want of a few sheets of 8 ½ by 11.

2. 	I want to add paper to the fax, photocopier, or printer, but I cannot find any.

First, check the storage area in the bottom drawer of the copier and storage cabinet in the copying/faxing area. If you don’t find any there, check the storage area in the router room (being especially careful not to trip over any power cords or Ethernet cables). If you don’t find any paper in back visit the documentation team. They have been known to hoard paper products. It may cost you…

3. 	I need to print out a document…Which printer I should use?

The printer that most everyone in the office uses is the HP Laser Jet 5, located in the fax/photocopier area. If you do not see this printer listed in the “Print” dialog when you attempt to print a document, you need to make the printer aware of your existence. Go to the Start Menu > Settings > Printers > Add Printer, and use the Add Printer wizard to get access. The HP Laser Jet is hosted by the server Phoenix. If you encounter complications, ask the Sales Support Engineer or Systems Administrator for help.

If you need/want to print out a document in color, there is a decent quality Cannon Bubble Jet printer that will do so. The Canon color printer currently lives in the Documentation office, and is hosted by the computer Naples. If you want to connect to this printer, you must ask the owner to give you access. 

�4. 	How do I reserve a place for meetings and what is available?

There are three main spaces used for meetings in the ILINC office: the Learning Zone (seating for 12), the front conference room (seating for 10), and the War Room (seating for 6-8). You must reserve the Learning Zone or the front conference room in the “ILINC Reservation Scheduler” in Lotus Notes. The War Room is typically used on an as needed basis, and a formal reservation is not necessary. Using Lotus Notes is discussed further in the section titled “Settling in.”

5. 	How do I reserve office resources for a product demonstration?

First, you need to reserve a place to conduct the demo in the “ILINC Reservation Scheduler” in Lotus Notes: the Learning Zone, front conference room, or the I-Net Demo Room (garage). If there is any special equipment you need to use, like a modem, check with the System Administrator about the availability of the equipment. Finally, if you are giving a demonstration that may have technical complications, be sure to check with the Sales Support Engineer to ensure that he/she is available to help. Using Lotus Notes is discussed further in the section titled “Settling in.”

6. 	What is this “firewall” thing and why do we have one?

A firewall is a computer, router, or other communications device that determines who has access to a protected network. 

A firewall protects our company network, or intranet, from unwarranted intrusion from the Internet while allowing us to access Internet services such as the World Wide Web and e-mail. Many firewalls now contain features to control, authenticate, and secure information about outside users who try to access a company's internal data from the Internet or from another company.

Firewalls are used in many organizations, not just those with Internet connections. They can be used to protect mainframe or other central resources from access within the organization, or to ensure that information passed across public networks (whether internal or external) remains secure.

Having a firewall at ILINC is especially important, since we frequently have customers or prospective clients connecting to our server for demonstrations, tests, and pre-scheduled LearnLinc sessions. Without a firewall, anyone connecting to ILINC could access internal company information. 

7. 	What is a “proxy server” and why do we have one?

The primary use of a proxy server is to allow users to access the Internet from within a firewall. A proxy server is a special server that usually runs on a machine that is responsible for maintaining the firewall. The proxy waits for a request for information from inside the firewall, forwards the request to the remote server outside the firewall, reads the response and then sends it back to the client computer that submitted the original request. 

The proxy  server is also helpful to those outside a firewall because it has the ability to cache files (to store files locally). This cuts down on bandwidth use, since many of the documents are retrieved from a local cache, instead of going out over the Internet to retrieve the document.

�8.	I found this really cool software that will also help me do my job…Will ILINC 	help 	pay for it? 

Yes. ILINC employees are authorized to spend up to $200, at any time, on work-related supplies, software, equipment, etc. If there is something you need- a desk light, a wrist rest, a new mouse, just go buy it, submit an expense report and receipt, and you will be reimbursed.

9. 	Someone asked for my computer account password (or the security system code 	and password) – should I give to them?

Never give your computer password or security system code to anyone, with the following exceptions: Everyone should leave a password with a supervisor or office mate when they leave on vacation or on an extended business trip. A coworker may need to log-on to your account to access specific source code or documents. Occasionally, a coworker may forget the security system code and password. It is OK to tell him/her the number, but do it in private, and not when there are customers or outsiders around. In a rare instance, a system administrator may need to know your network password to log-on and make an adjustment to your computer after you’ve gone home. 

You can change your computer password as soon as you return from your trip, or anytime you give someone else temporary access to your machine. The system prompts you to change your account password at least once every six months.

10. 	The chair that came with my desk is very uncomfortable and I cannot reach the 	keyboard…Will ILINC buy me a new office chair?

Yes. ILINC will reimburse you up to $125 towards the expense of a new office chair. Our favorite chairs have wheels and spin. (We realize this isn’t really a technical question, but c’mon, how would “Top 9 Technical Questions…” sound?)

�Got Lunch Plans?

Aaah, the age-old question…where to go for lunch? Here is a list of some of our favorite spots. So when one of your coworkers suggests Mr. Subb for the fourth day in a row, close your eyes and just point at a name on this list (if you point to Mr.Subb, you can do it over). Afterall, lunch is the most important meal of the day.

Fast food 

AJ's Deli (fresh Italian subs and sides)

Burger King

Breugger’s Bagels

Grand Union’s “Primo” Salad Bar (pay by the pound)

McDonald’s

Mr. Subb in Troy (fast, good sandwiches, big selection)

Pizza Hut

Taco Bell

Subway

Wendy's 

Not so fast food 

DeFazio's 

4th Street, Troy

$5-7 per person

Great pizza, reasonable prices.

Real homestyle Italian.

 

The Grove

across from HVCC on Route 4

$5-7  per person

Country bar/restaurant.

Good sandwiches, sit down.



Ground Round

Rensselaer Plaza on Route 4 South

$7-9 per person

Fast for large groups. Big selection.



Miss Troy Diner 

Pawling Avenue in South Troy

$5-7 per person

The real shiny diner experience. Just ask for Sal.

Cannot accommodate large groups of lunchers.



Moscatiello’s

½ mile from Tech Park on Route 4 Nouth

$5-7 per person

Good Italian food in a semi-formal setting.  

Good for a customer meeting.



Vivian's Diner

Rt. 9 & 20 Rensselaer

$4 - $7 per person

Typical Greasy Spoon, reminiscent of Mel's Diner

(they even call you “sugar”).

Very fast service.



Yonder Farms

Route 4, right at the end of Jordan Rd.

$5-7

Fast, ala carte.

Many good-looking pies and desserts.



�If you’re new in town…

Where is Troy?

7 miles north of Albany, NY 

16 miles east of Schenectady, NY 

21 miles south of Saratoga, NY 

120 miles west of Hartford, CT 

135 miles east of Syracuse, NY 

150 miles north of New York City 

175 miles west of Boston, MA 

222 miles south of Montreal, Canada 

284 miles north of Philadelphia, PA 

290 miles east of Buffalo, NY 

Troy is located in eastern upstate New York, near the junction of the Hudson and Mohawk rivers. Troy is part of a region called the Capital District, and is a10-minute commute from Albany, NY, the state's capital. The area is accessible by several highways, including the New York State Thruway (I-90, I-87) and I-787, a riverfront highway. Albany has an airport, two major bus stations, and just across the Hudson river, you can reach the area by Amtrak trains.

Troy History and Facts

Troy, a city of 55,000 people, is more than 200 years old. Located along the Hudson River in New York, Troy was a major center for the industrial revolution in the 1800's. It was the home of the detachable shirt collar, stove manufacturers, textile mills, stagecoach and carriage builders, breweries, bell manufacturers, iron and steel centers, and more. Iron plates for the Civil War ship the "Monitor" were rolled in Troy. Even Samuel Wilson, better known as Uncle Sam, lived and worked in Troy during this time. 

Most of Troy's buildings stand from the 1700-1800s; fine homes of former industrial tycoons, worker and factory housing, and homes of the emerging middle class are still used and lived in today, many retaining their original character and features. Wood frame, terra cotta, brownstone, and brick houses line the streets of the city. Queen Anne, Mansard, Beaux Arts, Romanesque, Italianate, Greek Revival, Gothic Revival, and other kinds of buildings can be seen everywhere in Troy.

�Living in Troy

There are many great resources online for finding out what’s going on in our area. The following sites have extensive, up-to-date information.

Dining 

Times Union “Living” section - http://www.timesunion.com/

Food and Spirits Guide to Troy - http://www.rpi.edu/Regional/Food/intro.html

Arts and Entertainment

Times Union “Living” section - http://www.timesunion.com/

Saratoga Performing Arts Center - http://www.global2000.net/spac/

Albany Symphony Orchestra - http://www.global2000.net/aso/

The RPI Events Calendar - http://www.rpi.edu/dept/NewsComm/Calendar/

New York State theatre Institute - http://www.crisny.org/not-for-profit/nysti/

Nightlife

Times Union “Living” section - http://www.timesunion.com/

Metroland Alternative Newsweekly - http://www.metland.com/

�Company policies

Security

Security is a big issue at any company, and can not be fully addressed in the scope of this document. However, we can give you some general guidelines for office and information security. 

Office Security

We have an alarm system in place for our offices. The Office Manager will tell you the security code and password, and inform you each time they are updated. Do not tell the code or password to people outside the company for any reason. If you believe that someone outside the company has become aware of the code, inform the Office Manager immediately. 

Information Security

Your position will likely put you in contact with company-sensitive information. Any documents, conversations, source code, or other materials that are indicated as confidential in either written or verbal format should never be repeated to customers, potential customers, the press, or anyone who is not an ILINC employee. Additionally, you may receive information that should not be given out to other ILINC employees. Use your common sense and discretion when distributing information internally.

First one in, last one out

If you are the first person to enter the office in the morning, you must disarm the alarm. You have approximately 1 minute to turn off the alarm once you open the door. If you enter the code incorrectly, you can try again immediately.  See the Office Manager for the current code and password. 

If you enter the building and do not disarm the alarm within one minute, the security company and the East Greenbush police are notified. First, the security company will call the office and let the phone ring twice. Answer the phone and give the security personnel the password (as given to you by the Office Manager). If you can’t remember the password, or you don’t get to the phone in time, the police will come to the office. Identify yourself as an ILINC employee, and the police will contact a pre-designated ILINC employee to verify your identity. 

If you are the last person out at night, you must arm the alarm.  The alarm is not armed until the door you exit is closed completely. Don’t forget to lock the door after you exit the office. Before you leave, you should check the following things:

Are you really the last person in the office? (walk through the entire office)

Is the coffee pot turned off?

Are all office lights turned out?

Are the front door, door to the hallway (by the kitchen), and the back door all locked?

Monitors, printers, copier turned off? NOT the fax machine!

Dress code 

If you haven’t already noticed, we’re a pretty casual office. However, here are a few general guidelines: 

If you meet with customers or visitors in the office, or on-site, dress professionally. Remember, you’re a representative of ILINC.

If you’re attending a trade show as a presenter, talk to your coworkers about the “uniform.” Generally, an ILINC shirt (supplied by the company) and black or tan pants are appropriate.

If you spend all day in your office, and no one but other employees will see you, look generally presentable, and keep in mind that sales people do walk visitors through the office.

Casual dress (jeans, shorts, etc.) are acceptable depending on the day’s activities

Customer interaction

The amount and type of customer interaction you’ll have depends on your position. If you deal with customers on a regular basis, talk to your manager about appropriate conduct and etiquette. If you find yourself meeting a customer in the hallway, or unexpectedly picking up a support call keep the following in mind:

Politeness, politeness, politeness.

If a customer asks you for help, respond immediately. Be helpful, but don’t overstep your bounds. If you don’t know the answer to a question, don’t answer it. Get the right answer, or refer them to the right person.

Watch your language. In a relaxed office environment it’s easy to get into the habit of taking liberty with the language (swearing, slang, etc.). Be especially mindful of this when talking to visitors.

Foreign visitors are fairly commonplace in the office. If you think a particular phrase or gesture might be offensive – avoid it! Use common sense, and remember that good will translates easily. If they see that you’re trying hard, chances are they will try to overcome language and cultural barriers as well.

Politeness, politeness, politeness.



�Internal communications guidelines 

Internal communications could take up an entire book itself, but we’ll do our best to provide some useful guidelines here concerning:

meetings

e-mail

voicemail

telephone

Meetings

There are two parts to scheduling a meeting: reserving a meeting place, and notifying meeting attendees of time, place, and agenda.

To reserve a meeting place, use the “ILINC Reservation Scheduler” in Lotus Notes. To make your reservation:

Open the ILINC Reservation Scheduler by double-clicking on its icon in Lotus Notes.

To see the current reservations, select a view. You can view reservations by date or room. You can also view your reservations, or a description of the available rooms.

To create a new reservation, click Create Reservation. 

Enter the date, start time, and end time for your reservation.

Click Room Availability to see which rooms are available.

Select a room and click OK.

Enter a description of the event if desired, and click Done to make your reservation.

Meeting etiquette 

Plan your meeting time accordingly. If you run overtime, be considerate of others who have reserved that room – finish your meeting at a later time, or in another room. 

Clean up after yourselves. If your meeting involves lots of paper, or food, make sure you leave the room in neat order. Our meeting rooms make an impression on our visitors, too.

You can use e-mail, voicemail, or personal invitations to notify attendees about your meeting. Whichever method you choose, remember to:

Give attendees plenty of advance notice

Distribute an agenda or a general idea of the topic, depending on the formality of the meeting.

Reserve a meeting room in advance



Meetings you should know about

There are a few departmental and company meetings that take place weekly. Chances are you’ll have to attend at least one or two of these events:

Company meeting – the company meeting is held every Thursday at 4:30pm in the Learning Zone. Attendance is mandatory. Company meetings usually include a report from each department head, with input from employees who have news to add; and a chance for everyone to ask questions, make announcements, and add their two cents. Expect to spend an hour to an hour and a half. Beer and chips on the house.

Development meeting – the development meeting is held every Monday at 4pm in the development lounge. Attendance is mandatory for developers, and customer service attends when possible. Developers should make sure to post a weekly status report via e-mail earlier in the day. The meeting usually entails giving progress reports on current projects, asking questions about current and future projects and plans, and lots of good-natured ribbing. Expect 45 minutes to an hour.

Sales meeting – the sales meeting is held every Monday at noon in the Learning Zone or Front Conference Room, depending on what space is available. Attendance is mandatory for salespeople and marketers.

�E-mail

The standard mail client for office use is Microsoft Exchange. Your e-mail account should be assigned to you on your first day. If you don’t know your e-mail address, ask your supervisor. Generally, e-mail accounts at ILINC are as follows: first name, initial of last name, followed by @ilinc.com, ex. johnd@ilinc.com.

Internal Group Accounts

There are several internal group accounts at ILINC that you can use to contact multiple recipients. These accounts, as well as individual accounts for all ILINC employees, are available to you in your MS Exchange Address Book.

administration-l@ilinc.com – Office Manager and Accountant

customerservice-l@ilinc.com – Manager of Customer Service.

development-l@ilinc.com – all of development (coders, testers, writers), including Managers of QA and Tech. Comm., and Vice President of Development.

office-l@ilinc.com – entire office.

productization-l@ilinc.com – productization team, generally consists of Managers of Technical Communication, Marketing, Customer Service, Development Project Leads, and VICE PRESIDENT of Development.

sales-l@ilinc.com – sales and marketing, including Vice Presidents of Sales and Marketing.



Generic Accounts

There are also three generic accounts that the rest of the world can use to contact ILINC:

info@ilinc.com – general information account that appears in most marketing literature. This account is monitored by the Office Manager, who forwards messages to the appropriate persons.

custserv@ilinc.com – customer service inquires, appears on product packaging, and wherever customer service manager deems appropriate. This account is monitored by the Customer Service Manager.

webmaster@ilinc.com – questions, comments, problems with ILINC Web site are sent to this account. Appears on all pages on the ILINC Web site, and is monitored by the Webmaster.

�Email etiquette 

Keep e-mail short and to the point. If it takes more than a few minutes to write it out, you should probably go talk to the recipient in person.

If you send or receive an e-mail that should be kept for future record, copy it into the appropriate database in Lotus Notes. Lotus Notes is the best place to store important company information.

You can use your account to send and receive personal e-mail, however please be reasonable about the amount of time you spend reading or composing personal messages.

Don’t flood the company’s’ inboxes with junk e-mail. There are some informal e-mail lists in the office for distributing jokes and information of general interest. Ask around if you’d like to be included on one of these lists. 

�Voicemail

Each ILINC employee has a voicemail account. To set up your account, please see the section entitled “Using ILINC’s Phone System.” Use voicemail to leave or forward important messages. 

Voicemail etiquette

Don’t use voicemail to avoid answering your phone. If you’re in the office, take the call – it could be a customer or coworker in need of help.

Keep messages short and to the point. If the subject is complex or detailed, leave a message asking the recipient to see you to discuss the matter in person.

If you know you will be out of the office, leave an extended absence greeting notifying listeners of how long you’ll be out, when you’ll be back (and available), and other people they can contact to handle an emergency. 

Telephone

Your telephone activity depends on your position in the company. Generally, those in sales, administrative, and support positions tend to have a lot of telephone interaction as representatives of ILINC. Please remember to be courteous and professional at all times when you are speaking on behalf of ILINC. 

Generally, personal phone calls are permissible as long as they don’t interfere with your ability to get your job done well, and on time. 

 











�Company Organization Chart
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�Office tour 

The ILINC Corporate Headquarters are located at 385 Jordan Road, Troy, NY 12180-7601. ILINC occupies one side of a larger building that houses several other businesses as well. The office is divided into several main areas, which are described and below. 



�





Reception Area�The reception area is at the official entrance to the ILINC offices. If you have invited guests to the company offices, you can direct them to the reception area. The receptionist will greet your guests, notify you of their arrival, and make them comfortable until you can come up front to meet them. 

The Learning Zone�The Learning Zone is the main presentation room, and has a capacity of about 12 people. It contains anywhere from eight to twelve computers, and a large conference table in the center of the room. It also has a projection screen and a sophisticated projector that can be used to display a computer screen or videos. The small room off of the Learning Zone is the instructor’s room. It contains one computer, and can be used to simulate a distance learning experience. The Learning Zone is used for monthly workshops, office meetings, ProShare calls and software demonstrations, and meetings with potential clients and customers. You must reserve the Learning Zone using the Reservation Scheduler database in Lotus Notes.

Kitchen�The kitchen is next to the Learning Zone. It can be accessed through the Learning Zone, or from the back hallway. The kitchen has a communal refrigerator, microwave, coffee machine, and sink. Many people use the kitchen throughout the day, including the occasional client, so please clean up after yourself. Also, label food that you leave in the fridge – otherwise it may be considered community property.

Front Conference Room�The front conference room is available for meetings of up to ten people. This room has a conference table, and two to three computers for ProShare calls and software demonstrations. You must reserve the Front Conference Room using the Lotus Notes reservation scheduler.

War Room�The War Room is a smaller, less formal meeting room. It can accommodate five or six people comfortably, and has a small table and an assortment of chairs – you may want to bring your own.

Router Room�The Router Room contains routers (as the name implies) as well as servers, workspace for the system administrator, and storage of office, marketing, and production supplies. Generally, all of the materials you’ll need are located in the administrative area of the office, or can be requested through the Office Manager. Please do not take supplies from the router room without asking.

Demo Room�The demo room is a special area setup specifically for giving software demonstrations. The demo room is located in the garage area, across from the router room. See the Sales Support Engineer for information about the setup and use of this workstation.

Administration�The Office Manager and Account share the Administrative office. The President’s office is next to the Administrative office. Across from these offices you’ll find the copier area – which houses our copier, fax machine, printer, and many office supplies. You’ll also find current marketing materials here. 

Development�Development occupies most of the back of our office space. Aside from Technical Staff (including the Technical Communications office), the Development area includes the development library and the development lounge.

Quality Assurance/Testing Lab�Quality Assurance area house the Quality Assurance Manager and Engineer, and the System Administrator. The testing lab is also located in the Quality Assurance area. The router room is adjacent to the Quality Assurance area.

Sales and Marketing�Sales and Marketing occupies most of the front of the office. Aside from Sales and Marketing personnel, the Sales Support Engineer and the Success Team Leader can be found here.



�Settling in

We want you to be comfortable in your new work environment as soon as possible. So, here’s a list of things you can do to get on track (as if trying to remember 35 new names isn’t enough). Once you finally get an uninterrupted moment to sit down at your new work area, you will notice a computer and phone sitting on your desk. Take some time to adjust your chair, monitor, and keyboard to achieve the proper ergonomic arrangement. Now you’re ready to get busy.

Setting up your voice mail 

More features of ILINC’s phone system are described in detail on page XX. You should set up your voice mail account immediately.

Find your extension number

To find your phone extension, find the top row of buttons on the right side of your phone. Your extension number appears above the first button in this row.

Set your voice mail password 

Pick up the receiver and dial 333.

When you hear “Thank you for calling ILINC,” press #.

Enter your mail box number (your extension).

Enter the default password, which is 1111.

Press 4, for “Personal Options.”

Then press 1, for “Passwords.”

Then press 5 to enter your “Personal Password,” and follow the verbal instructions.

Record your voice mail message

Pick up the receiver and dial 333.

When you hear “Thank you for calling ILINC,” press #.

Enter your mail box number (your extension).

Enter the password that you specified earlier.

Press 4, for “Personal Options.”

Then press 2 for “Greetings,” and follow the verbal instructions.

�Setting up your computer (Non-Technical Staff)

Change your passwords  

The first time you use your computer at ILINC, you should change your Microsoft Networking password and passwords for your e-mail account and Lotus Notes. 

To change your passwords, you must log-on to the network using the default password: After your computer starts up, you will see the “Enter Network Password” dialog box. Your log-on name and the domain name “ILINC” are already filled in. In the “Password” field, type the word “password.”

Your Windows 95 desktop appears after a moment. Proceed changing your passwords. 

Networking Password

Click Start > Settings > Control Panel.

When you see the “Control Panel” dialog, double click the entry “Passwords.” You will see the “Passwords Properties” dialog.

Click the button marked “Change Windows Password.” You will see the “Change Windows Password” dialog.

Enter the word “password” in the “Old Password” field, and your new one in the “New Password” and “Confirm New Password” fields. Remember, passwords are case sensitive.

Click OK, and close all dialogs.

E-Mail Password

In Microsoft Exchange, select Tools > Services > Internet Mail > Properties.

Highlight the hidden text (xxxx) in the “Password” field.

Type in your new password, and click “Apply.”

Click OK to close all windows.



Getting Started>> Check your Inbox in Microsoft Exchange

The Inbox is the directory in Microsoft Exchange to which all of your e-mail is delivered. To have your mail delivered, click Tools > Deliver Now. If you have mail, new messages will start popping into your Inbox. To read a message, simply double click on it.

�Lotus Notes Password

Click Start > Programs > Lotus Applications > Lotus Notes.

Click File > Tools > User ID.

Enter the default password for Lotus Notes, which is “notes”. You will see the “User ID” dialog.

Click the button marked “Set Password.” You will be prompted to enter the default password again, do so, and click OK.

Enter your new password, click OK. Remember, passwords are case sensitive.

Confirm your new password by entering it one more time, click OK, then click “Done.”�

Getting Started>> Access databases in Lotus Notes

Lotus Notes provides a means of  creating, organizing, and archiving documents in a database format. Documents in Notes are an excellent source of information about the history of ILINC and our products. Databases include information on everything from company information to suggestions on how to make our products better. You can access several databases in Lotus Notes, some of the most important being:

Company Forum

ILINC Reservation Scheduler

Sales-Marketing Forum

Product Suggestions

Competitor Updates

Weekly Sales Meetings

Development Forum

To read the documents stored in a database, simply double click on its icon. You will see a list of documents that can be sorted by topic, author, date created, status, or by some other method. To read a document, double click on its entry.

�Installing Software

Now that you’ve changed all of your passwords and have a secure system, see what other  software is installed on your computer. Which software is already installed for you depends on what your position at ILINC entails. The standard software set up for a new employee typically includes:

Windows 95

Microsoft Office 97

Internet Explorer 3.0

LearnLinc

Lotus Notes

McAffee Virus Scan

WinZip or PKZip

In addition to these basics, there is software you need to complete tasks that are specific to your position. The table that follows lists the software you should have installed on your machine, according to department.��

Specialized software by department���Administrative and Accounting�ABRA (Human Resources tracking)

UPS Tracking

Peachtree Complete Accounting�ADP Payroll�Sales and Marketing and Customer Service

SalesLogix

ProShare Videoconferencing System (optional)��Software Development

Windows NT (required)

Microsoft Office 97

Adobe Acrobat

Visual Source Safe

Visual C++ (16 bit)

Visual C++ 4.0 (32 bit)

Microsoft Developer’s Library

Developer Source

Bounds Checker

DBWin 32 

InstallShield (optional)

Win32 SDK (optional)

MKS ToolKit (optional)�Technical Communication

Windows 95 

Framemaker

Photoshop

Illustrator

Acrobat Exchange

Type Manager and Fonts

Visual Source Safe

Quark Xpress

PaintShop Pro

Clip N Save

Front Page

RoboHelp (WinHelp Office)��Multimedia Development

Multimedia ToolBook�Authorware�Director�3D Studio

Hypercam

Sound Forge

Software Development Tools�Other Availble Software 

Netscape Navigator

ProShare Videoconferencing System

Fractal Painter

Kai’s Power Tools��

If you want to install software from this list and are unfamiliar with the process, have the Sales Support Engineer or System Manager assist you. If you want to install the software yourself, you can get CD ROMs of the applications from the System Administrator. 

Finding Manuals and Tutorials

If you are unfamiliar with some of the software we use here at ILINC, there are several ways you can quickly familiarize yourself with the basics. In addition to online help, there are sometimes hard copy manuals you can reference for more information. 

Some software products offer a tutorial to teach you the basic skills you need to use the application. Since tutorials tend to take up a lot of disk space and are used occasionally, you most frequently find them on the CD ROM used to install the application. Sometimes tutorials are installed with the application, and everything you need to use the tutorial is in the same directory as the application.

�Setting up your computer (Technical Staff)

Technical staff are expected to set up their own workstations when starting at ILINC. To learn what our development environment is like, see the software list on the previous page. Talk to your supervisor to find out what applications you should install. There are additional tools available that may not be on this list- ask around if you are looking for a particular tool or piece of software.

�Introduction to the Network

A network is a system of computers, terminals, or databases connected by communications lines. At ILINC, our network is made up of computers connected by Ethernet cables. For easy tracking, each computer on the network has a unique name, which corresponds to the name of a major city.

A network is not only made up of connected computers (hardware) but also software that is used to monitor performance, diagnose problems, and maintain resources on the network. The software used to administer our network is Microsoft NT.

Exploring the Network

The best way to get an overall view of the network is to use Windows Explorer. To open Explorer, click Start > Programs > Windows Explorer. When Explorer opens, you will notice a list of drives on the left hand side of the window. (If you only see an icon or text with a (+) sign in front of it, click on the (+) to expand your view of items in the hierarchy.) At the top of this list is the name of your computer, and a list of local drives:

A: (3 ½ floppy drive)

C: (hard drive 1)

D: (hard drive 2)

E: (CD ROM drive)

Following the local drives is a list of network drives. Certain computers on the network are not used for everyday tasks. Their sole purpose is to store information, documents, applications, and other data. When something is “up on the network” or “stored on the network” is exists on a the hard drive of a computer on the network. You should see some or all of the following network drives listed in Explorer:

K (hosted by Atlanta) - The K drive is the home of all software applications that are shared throughout the company. You may install something from this drive, but it is not intended for personal storage of any applications or data.

L (hosted by Atlanta) - The L drive is the place to store documents or files that need to be accessed throughout the company. Documents stored there include artwork, marketing materials, product documentation, fax attachments, etc. You can use the L drive as an additional storage place for files. Files not intended for public use should be stored in L:User/your name directory.

M (hosted by Atlanta)  - The M drive is for Development staff use only. It is the drive developers use to store source code and programs they are working on.

R (hosted by Atlanta) - The R drive is an archive drive that developers use to store source code and programs. 

U (hosted by Atlanta) - The U drive is the home of the Microsoft Developer’s Network for use by developers.

V (hosted by Rome) - The V drive hosts the Proxy Server. Don’t touch anything on this drive.

Below all of the local and network drives, you see “Network Neighborhood,” which lists the names of all other computers on the network. 

�Additional Hardware Available to Employees

In addition to the equipment available for your personal use, there are some other pieces of “community” hardware at your disposal. As with other shared resources, be sure no one else has dibs before using this equipment.

Laptop computers

ProShare videoconferncing

PolyCom for conference calls

Flatbed scanner

Zip drives

TV/VCR

Projection facilities in the Learning Zone

Old-fashioned Overhead projector

�Company Directory



Department�Title�Name�Ext.��Executive Team�President�James O’Keefe�411��Executive Team�Exec. Vice President of Sales�Mark Bernstein�412��Executive Team�Vice President of Development�Degerhan Usluel�451��Executive Team�Chairman�Jack Wilson�none��Executive Team�Chief Financial Officer (CFO)�Don Kintner�424�������Administration�Office Manager�Chasity McGivern�401��Administration�Accountant�Kelly Bariteau�427��Administration�Receptionist�Angie Hayes�0�������Sales Department�Eastern US Sales Manager.�Mala Abraham�414��Sales Department�Central US & Canada Sales Manager�Dave Collins�416��Sales Department�Western US Sales Manager�Ken Pulvino�417��Sales Department�International Sales�Angela Richer�445��Sales Department�Western Region Account Executive�Rich Ream�none��Sales Department �Central Region Account Executive�Pete Dignan�none��Sales Department�Sales Support Engineer�Christine Mattaini�418��Sales Department�Success Team Leader�Debra Eves�415��Sales Department�Inside Sales Support�Amy Stahlman�425�������Marketing�Marketing Manager�Norm Ainslie�420��Marketing�Multimedia Specialist�Sean Stahlman�477�������Customer Service�Customer Service Manager�Adam Stewart�440��Customer Service�Customer Service Engineer�Scott Meade�488�������Development�Senior Member of Technical Staff�Mike Petersen�466��Development�Senior Member of Technical Staff�Josh Muskovitz�456��Development�Senior Member of Technical Staff�Mike Ketchen�458��Development�Member of Technical Staff�John Waiveris�457��Development�Member of Technical Staff�Tolga Yazar�478��Development�System Administrator�Mike Wood�455�������Technical Comm.�Technical Communications Manager�Amy Lattof�475��Technical Comm.�Technical Writer�Susan Kushner�479�������Quality Assurance�Quality Assurance Manager�Jim Harrigan�454��Quality Assurance�Quality Assurance Engineer�Mike Petryk�453��

�Using ILINC’s Phone System 

Finding your extension number

To find your phone extension, find the top row of buttons on the right side of your phone. Your extension number appears above the first button in this row.

Setting or changing your voice mail password 

Pick up the receiver and dial 333.

When you hear “Thank you for calling ILINC,” press #.

Enter your mail box number (your extension).

Enter the default password, which is 1111.

Press 4, for “Personal Options.”

Then press 1, for “Passwords.”

Then press 5 to enter your “Personal Password,” and follow the verbal instructions.

Recording your voice mail message for the first time

Pick up the receiver and dial 333.

When you hear “Thank you for calling ILINC,” press #.

Enter your mail box number (your extension).

Enter the password that you specified earlier.

Press 4, for “Personal Options.”

Then press 2 for “Greetings,” and follow the verbal instructions.

Retrieving messages 

If you have a voice message, the red light above the button labeled “MSG” will be lit.

Hit the “MSG” button, and then “Hands Free.”

When you hear “Thank you for calling ILINC,” press #.

Enter your mail box number (your extension), then #.

Enter your password, then #.

Follow the verbal instructions.

Retrieving messages from outside the office

Dial (518)283-8799.

When you hear “Thank you for calling ILINC,” dial 333.

Enter your mail box number (your extension), then #.

Enter your password, then #. 

Follow the verbal instructions.

Putting a call on hold

Press the button marked “Hold” (lower left corner) and the put the receiver in its cradle. Notice that the red light below your extension number blinks while you have someone on hold. The phone will ring back after you’ve left someone on hold for 1 minute.

Taking a call off hold

Pick up the receiver, and press the “Hold” button. The red light below your extension number is no longer lit.

Transferring a phone call 

Indicate to the person with whom you are speaking that you are about to transfer him/her to another extension, and tell them the extension number in case you are disconnected. 

Press the “XFER” button (lower right corner), then dial the extension to which you are transferring him/her. You may hang up right after transferring the person, or stay on the line and introduce the transferee when the other ILINC employee picks up.  The person being transferred cannot hear you, or the person you are transferring him/her to, until you hang up.

�





About Our Company

�

About the company

Our mission 

ILINC sells complete distance learning solutions. We don’t just sell software, we offer customers everything they need to train employees successfully. Sure, our product line is made up of distance learning software and services, but our most important product is one that cannot put in a box or billed for by the hour. It is an idea. The idea that we can change the way people learn for the better. 

A quick history

ILINC was founded in March 1994, by Dr. Jack Wilson (a Dean at Rensselaer Polytechnic Institute) Mark Bernstein, and Degerhan Usluel (two graduating MBA students from RPI’s School of Management) in Troy, NY. Their main goal was to develop and commercialize LearnLinc, distance learning software. 

Within a little over a year, the founders’ vision became reality. The first commercial version of LearnLinc was shipped in June of 1995 by 5 exhausted programmers, one frazzled technical writer, and a sales person who’d been selling a non-existent product for months to keep ILINC alive. 

Our original customers included IBM, Sprint, AT&T, and Ernst & Young. Later releases of LearnLinc built our customer base to include corporations, government agencies, and universities from around the world.

In 1995, ILINC made some big changes in addition to shipping LearnLinc 1.0. We brought on a new president, Jim O’Keefe, and graduated from the RPI Incubator center (a start-up center for fledgling technology companies). We then moved to our current home in the Rensselaer Technology Park. 

Since then, we’ve grown significantly (around 30 employees by December 1996), and established ourselves as a serious contender in the distance learning/online learning market. In 1996 and early 1997, we expanded our product line from the original LearnLinc to three versions of LearnLinc. We created the service-oriented division of our company, the ILINC Success Team.

�The Executive Team Background

Currently, our Executive Team consists of four members: 

Dr. Jack Wilson, Chairman 

James O’Keefe, President and CEO

Mark Bernstein, Executive Vice President of Sales 

Degerhan Usluel (Deg-er-han Oo-slew-el), Vice President of Development 

Jack is the Chairman of ILINC, the Dean of Continuing and Undergraduate Education at Rensselaer Polytechnic Institute. Dr. Wilson directed the AT&T/ Rensselaer Interactive Multimedia Distance Learning Project and served as one of IBM's 14 National Consulting Scholars. He collaborates with the German Institute for Distance Learning and headed the US/Japan/China Trilateral Educational Planning Committee. Dr. Wilson serves as one of two civilian advisors to TRADOC.

Jim is responsible for day-to-day operations and is charged with growing ILINC into a world class provider of online learning software. He is the former Chairman of Image Systems Technology, a software development firm acquired by Softdesk/Autodesk. Jim began his career as Manager of Strategic Planning and Business Development at General Electric Company's Plastics Business Group. Prior to joining Image Systems, Jim founded Upstate Equities, a venture capital firm. Jim earned an undergraduate degree from the University of Toronto and an MBA from the University of Pennsylvania's Wharton School.

Mark is responsible for marketing and sales. Mark initiated and maintains alliances with Intel, Lucent Technologies, Macromedia, IBM, and other key industry leaders. At Computer Associates International Inc. Mark was ranked sixteenth worldwide from over 350 managers. He also helped found the consulting company Contingency Planning Research Inc. Mark earned his MBA from RPI in 1994.

Dare heads all aspects of technology and product development for ILINC. Development is responsible for research, product development, and quality assurance. Dare has nine years of experience in software product development and computer consulting. He founded USIMEKS, a software development and consulting company. Dare was the chief designer and programmer of SSE, a multi-user and distributed circuit design system developed for Bilkent University in Turkey. He was project manager for the Design and Manufacturing Learning Environment, a joint effort between RPI and the MIT Sloan Foundation. Dare was awarded RPI's prestigious Spafford Prize for his high scholastic ability and his contribution to the field of management. Dare earned his MBA from RPI in 1994.

�The RPI connection

You may have noticed that Rensselaer Polytechnic Institute (RPI) plays a prominent role in the history of ILINC. RPI is a local technical college that produces successful engineers, scientists, and other technical types. ILINC was founded by an RPI professor and two RPI MBAs, and several of our staff members have degrees from RPI. RPI was instrumental in our early success by housing us in the Incubator Center, and they continue to support our efforts to grow and succeed.  They also own the Technology Park, so as long as we pay the rent, they’re stuck with us.

Other than the associations mentioned above we are not affiliated with the RPI and they don’t have a vested interest in our success, other than hoping to see an “RPI start-up” do well.

�Company organization

A brief description of each department and its positions appears below. These summaries can’t possibly describe the full responsibilities of each position, rather they are provided to give you a general idea of what each person does, and who you might go to if you have a problem to solve.

Executive 

The Executive Team manages all aspects of the company, and plans its future direction. It consists of the following: President, Executive President of Sales, Vice President of Development, and Vice President of Marketing, and the Chief Financial Officer.

The President manages the day to day responsibilities of running the company. Additionally, the President coordinates the activities of the Executive Team, establishes profitable relationships with other companies and industry leaders, and works with the Board of Directors to determine the future direction of the company.

The Executive Vice President of Sales oversees the Sales Team and sales process, and determines target markets for ILINC products. Additionally, the Executive Vice President of Sales maintains relationships with his customers, and builds the customer base by courting new customers.

The Vice President of Development oversees the Development Team, the development process, and the future direction of our product lines. He creates a “Technology Roadmap” that forecasts our products’ direction. Both Quality Assurance and Technical Communication are in the Vice President of Development’s domain.

The Vice President of Marketing coordinates the promotion of ILINC and its products and services. He or she works with advertising, Public Relations, and design firms to create a media campaign and nurture strategic alliances with leaders in complimentary industries.

The Chief Financial Officer is responsible for the financial management of the company. The Chief Financial Officer works closely with the Accountant to perform monthly financial reviews, prepare for yearly audits, and present financial reports to the Executive Team and the Board of Directors.

�Administrative

The administrative team manages the day to day needs of the office, including employee benefits, finances, and office management. The administrative team consists of the Office Manager, Accountant, and the Receptionist. 

The Office Manager manages all human resources activities including employee healthcare, 401K, and insurance (disability, worker compensation, etc.). Additionally, the Office Manager is involved in customer relations, coordination of company events, and assisting the Executive Team. The Office Manager reports to the President.

The Accountant is responsible for all financial reporting to the Chief Financial Officer and Executive Team, accounts payable and receivable, payroll, inventory of products, and other financial tasks as assigned by the Executive Team. The Accountant reports to the President and the Chief Financial Officer.

The Receptionist greets guests as they arrive at ILINC, answers the multi-line phone system, and completes administrative tasks as assigned by the Office Manager. The receptionist reports to the Office Manager.

�Sales 

The Sales Team, which consists of Regional Sales Managers, the Success Team Leader, and a Sales Support Engineer, sells ILINC products worldwide through direct sales, trade shows, and VAR management and sales.

The Regional Sales Managers are responsible for finding, developing, and closing sales leads in their assigned sales territories. Regional Sales Managers also manage relationships with and support the Value Added Resellers (VARs) in their regions. Regional Sales Managers report to the Executive Vice President of Sales.

The Success Team Leader works with new customers to ensure that their ILINC software implementations are successful. The Success Team Leader calls on customer service, multimedia developers, and others to make sure that new customers have all of the accessory hardware and software necessary to implement an ILINC product, and works with them make sure they have content, and a roll-out plan for their implementation.

The Sales Support Engineer maintains and supports the hardware and software for the Sales Team. Additionally, he or she troubleshoots hardware and software problems for demonstrations and trade shows, and may travel with sales people to these events. The Sales Support Engineer is also involved in planning the technical aspects of new sales projects. The Sales Support Engineer reports to the Executive Vice President of Sales.

Marketing

The Marketing Team promotes ILINC and its products through print and online presentations, press relations, and promotional media. The Marketing Team consists of the Marketing Manager and Multimedia Specialist.

The Marketing Manager plans and coordinates advertising campaigns, media events, and trade shows. The Marketing Manager also writes copy for marketing sheets, and works with advertising and media relations firms to coordinate ILINC’s marketing strategy. The Marketing Manager reports to the Vice President of Marketing.

The Multimedia Specialist works with the Marketing Manager to produce printed marketing pieces. He or she also works with sales people to produce sales presentations and demonstrations, and with the Webmaster to make Web updates and perform Web maintenance. The Multimedia Specialist reports to the Marketing Manager.

�Development

The Development Team produces ILINC software products, plans the future direction of the ILINC product line (based on the input of Sales, Marketing, and customers), and supports the non-technical areas of the company. Two additional departments, Technical Communications and Quality Assurance, are also part of development.

Senior Members of Technical Staff lead the Development Team (along with the Vice President of Development) in creating, revising, and maintaining ILINC software projects. Additionally, they serve as Project Leads, and may specialize in a particular branch of software development (ex. Interface design vs. software architecture). Senior Members of Technical Staff report to the Vice President of Development.

Members of Technical Staff work on software projects as determined by the Vice President of Development or by the Development Team. As with senior developers, they may also specialize in a particular branch of development. Members of Technical Staff report to the Vice President of Development.

The System Administrator is responsible for maintaining office network, hardware, and software– including servers and routers. The System Administrator works with other ILINC employees to troubleshoot their computer problems and keep their systems upgraded. Additonally, all requests for equipment for trade shows and out-of-office events are handled by the System Administrator. The System Administrator reports to the Vice President of Development.

Technical Communications	

The Technical Communications team creates, maintains, and revises all printed and on-line documentation, including software manuals, online help, and the ILINC Web site. The Technical Communications team consists of the Technical Communications Manager, and Technical Writer.

The Technical Communications Manager coordinates the development, production, and maintenance of all technical documentation and software production and packaging. Additionally, the Technical Communications Manager oversees the development and maintenance of the ILINC Web site. The Technical Communications Manager reports to the Vice President of Development.

The Technical Writer works with the Technical Communications Manager to develop product documentation and online help. The Technical Writer also works with the Marketing Manager and Multimedia specialist to edit and proof Marketing materials and presentations. The Technical Writer reports to the Technical Communications Manager.

�Quality Assurance

The Quality Assurance Manager designs and oversees testing and quality assurance for all ILINC software products. Additionally, the Quality Assurance Manager participates in planning, development, and production of new software products, and works with the System Administrator to design and maintain the office network. The Quality Assurance Manager reports to the Vice President of Development.

The Quality Assurance Engineer works with the Quality Assurance Manager to test ILINC software products. The Quality Assurance Engineer also designs and develops installation programs for software products. The Quality Assurance Engineer reports to the Quality Assurance Manager.

Customer Service

The Customer Service Team supports ILINC clients who have current maintenance agreements. They handle support calls, travel on-site to troubleshoot problems with software and equipment.

The Customer Service Manager coordinates all customer service accounts and activities. Additionally, the Customer Service Manager works with other teams to plan events and projects that will require either internal or customer technical support. The Customer Service Manager reports to the President.

The Customer Service Engineer works with the Customer Service Manager to support customers by phone and on-site. The Customer Service Engineer may also assist the Sales Support Engineer, or Quality Assurance with internal support issues. The Customer Service Engineer reports to the Customer Service Manager.



�About our products

The History of LearnLinc

In 1992, Jack Wilson’s research group at RPI was challenged by AT&T to create an interactive multimedia distance learning environment. Working with Degerhan Usluel as an expert on programming, networking, and management, they re-designed a course from AT&T’s University of Sales Excellence (USE), an internal training and education organization supporting marketing staff in the Business Communication Services division of AT&T. The Course, “How to Make Money Grow on Trees,” teaches the features of AT&T Advanced 800 Services call routing and how to apply those to customer applications. Rensselaer created the multimedia materials and did the workstation programming for the project. AT&T Bell Labs took on the network programming.

In June of 1993, they tested the IMDL environment with live participants. The University of Sales Excellence course that they developed was delivered by an instructor in Cincinnati, Ohio. The participants were located in Dallas, Texas, Chicago, Illinois,  and Holmdel, New Jersey. The first “trainees” were actually other AT&T instructors, who volunteered to participate.

In 1994, ILINC was spun off from Rensselaer to design, construct, and disseminate the new learning architecture, which was called LearnLinc.

Since LearnLinc 1.0, we have made significant advances to the LearnLinc technology, including branching the original product into three versions, each with its own connectivity solution: LearnLinc LAN/WAN, LearnLinc Pro-Net, and LearnLinc I-Net. LearnLinc LAN/WAN relies on the original connectivity solution – IP multicasting over LANs and WANs. LearnLinc I-Net provides our virtual classroom environment over the Internet or corporate intranet however, it does not include videoconferencing. LearnLinc Pro-Net combines the Intel® ProShare® videoconferencing technology with LearnLinc to provide videoconferencing via ISDN lines, and all other data sharing via an Internet or intranet connection. 

For a more detailed description of each product, please read the current marketing literature, which is included in your orientation packet.

LearnLinc Technology Overview

Insert text here- something already done for the workshop?

�Overview of LearnLinc-related terms

As you learn more about LearnLinc, you’ll find many new terms to familiarize yourself with. The terms defined below will give you a good start, though this list is by no means comprehensive.

Application synchronization – using a sync-enabled application interactively during a session. The application is launched on all participant’s machines, and the actions of the floor holder are seen by all.

Bandwidth - the carrying capacity of a digital communication channel, usually given in kilobits per second (Kbps), kilobytes per second (KBps) or megabits per second (Mbps). A 10 Mbps Ethernet LAN, for example, can carry much more data than a 28.8 Kbps modem.

Client-Server architecture

Connectivity 

Data and content administration 

Distributed virtual classroom - the environment created by LearnLinc. The distributed virtual classroom combines the interactivity of a traditional classroom with the communication and multimedia �capabilities of the desktop computer. 

Floor control policy - each live interactive session has a format, or style of presentation, known as the floor control policy. The floor control policies that are currently available are “instructor led,” “directed discussion” and “open discussion.” The participant who has the floor can be seen and heard by the rest of the participants in the session, direct the �participants to a particular resource by launching it on all participant’s computers, make annotations and synchronize applications.

IP address - IP addresses are used to identify a node on a network and to specify routing information. Routers use IP addresses to direct data packets from one LAN to another. Each workstation on a LAN must have a unique IP address.

IP Multicasting - a method of transmitting packets in a TCP/IP network that allows a sent packet to be received at multiple destinations. It is similar to IP broadcasting; with appropriate routing, however, a multicast packet is not limited to a single segment. LearnLinc uses multicasting for sending commands, sharing data, and live videoconferencing.

LAN (Local Area Network) - A LAN is a high-speed communications network used to connect computers for information and resource sharing. 

Networking	

Sync agent™ - each sync-enabled application has a sync agent. The sync agent provides the capability for fully interactive application synchronization during a session.

TCP/IP (Transmission Control Protocol/Internet Protocol) - a widely popular networking protocol standard. All of LearnLinc’s network traffic uses this protocol.

Videoconferencing - live video and audio transmission during a session. The scheduler of a session determines the videoconferencing configuration for a session.

WAN - Wide Area Network. WANs are usually used to connect LANs at multiple sites, allowing network connectivity throughout the enterprise.

�Industry Overview

Insert Text Here

�More Frequently Asked Questions

Working with customers

1. 	I saw a stranger wandering around the office…How should I approach her? 

Smile, say hello, introduce yourself, and ask if there is something you can help her with. If she is looking for a particular person or office, escort her to that person or room. If she is just looking for someone to answer a question or talk to about the company, offer her some coffee and take a few minutes to converse. We don’t mind going out of our way to make customers feel comfortable. However, don’t overstep your bounds or answer questions not in your field of knowledge.

2. 	I’m picking up my mail and a customer walks in. No one else is around – what 	should 	I do?

Smile, greet him politely, and introduce yourself. Once he returns the introduction, ask who he is here to see. Notify appropriate person that so-and-so is here. If it will be a few minutes, offer him some coffee, tea, or soda.

3. 	I’m picking up my mail and the phone rings. No one else is around – what should I do?

Answer it, don’t walk by. It’s easy, just pick up the receiver, smile, and say “Thank you for calling ILINC. This is ____. How may I direct your call?” If the caller gives you an answer, transfer her to the appropriate person. If she is not sure, find out if she is a current customer with a question (transfer to Customer Service) or interested in some of our products (transfer to the Vice President of Sales). Now, wasn’t that simple?

4. 	A salesperson drops by my office to introduce some customers. What should I say to 	them?

Smile, say hello, and continue working. Unless they have a question specific to your expertise, it is likely that the salesperson will introduce you, keep right on talking, then direct them to the next office. If a customer or the sales person has a question for you, put your work aside and give them your full attention, until their thirst for knowledge is quenched. 

5. 	How can I find out (ahead of time) when customers are visiting the office?

Usually, if there are very important clients visiting the office, an e-mail will be sent to everyone in the company as notification. Your next line of defense is the laminated planning calendar hanging in the photocopier/faxing area, which lists many visits/events that have been planned in advance, including workshops, user group meetings, etc. However, this calendar often doesn’t list individual clients or corporate representatives who are planning to drop by. A boundless source of information is the Office Manager. Ask weekly if there are any customers coming into town (although he/she sometimes doesn’t know until the last minute, either) and adjust your schedule and wardrobe accordingly. Also, the company meeting (each Thursday at 4 p.m.) is chock full of announcements of this nature.

�6. 	A customer asked me a question about the new features we might include in future 	products…How should I handle it?

Say, “I’m not the right person to answer that question.” Period. You can refer the customer to the Vice President of Development or a Senior Developer. If she has a suggestion, write it down, and submit it to Development via the “Product Suggestions” database in Lotus Notes.

7. 	A customer asked me a very technical question about a product…To whom may I 	refer them for a technical answer?

Politely tell him that his question is beyond your realm of knowledge, and you will refer him to someone better qualified to provide the correct answer. If his question pertains to hardware, equipment, or networking, refer him to Customer Service. If his question is about software or features, refer him to the Vice President of Development, or a Senior Developer.

8. 	A customer made a good suggestion about how to improve a product. Where do I 	record this information?

You must create a “feature request” or bug report in Lotus Notes. It is not sufficient to verbally mention requests or complaints to a developer. The appropriate place to document customer input is in the “Product Suggestions” database in Lotus Notes. This produces a set of permanent records of ideas and “fixes” that Development can consider for inclusion in software updates, or as new functionality in the next line of products.

�

Who can I ask for help?���I need to FedEx or UPS a package.�Ask the Receptionist or Office Manager��I can’t get my voice mail to work.�Ask your supervisor, Sales Support Engineer, or Systems Administrator.��I’m having trouble with my computer.�Ask the Sales Support Engineer or System Administrator for help.��Umm, I think I broke the copier.�Ask the Receptionist, Office Manager, or anyone walking by.��Umm, I think I broke the fax machine.�Ask the Receptionist, Office Manager, or anyone walking by.��I want to download something from the Internet, should I?�Ask the Sales Support Engineer or System Administrator.��I want to download something from the Internet, but I don’t know how.�Ask the Sales Support Engineer or System Administrator.��I want to install new software that I downloaded from the Internet. Who do I ask to make sure it’s safe?�Ask the Sales Support Engineer or System Administrator.���

Who do I ask for reliable information about…���…product system requirements?�Consult sales materials, documentation, Customer Service.��…compatibility and interoperability of products?�Consult sales materials, documentation, Customer Service.��…product pricing?�Consult sales materials, a sales person, Executive Vice President of Sales, or the Vice President of Marketing.��…product discounts or special promotions?�Consult sales materials, a sales person, Executive Vice President of Sales, or the Vice President of Marketing.��…how a particular feature of one of our products works?�Ask a Senior Developer or the Developer who created it.��…when a product is scheduled for release?�Ask the Vice President of Development.��

�Traveling for the company

1. 	Why would I need to travel for ILINC?

If you are in the Marketing and Sales Department, you are expected to attend conferences and trade shows as an ILINC representative. If you are a member of the Administrative or Development staff, you may attend conferences or seminars about new technologies, or training on how to use new software. Customer Service representatives frequently travel to customer sites to troubleshoot problems or install and configure hardware and software. Technical staff may be assigned to travel to trade shows or customer sites to provide technical support.

2. 	Who takes care of transportation and hotel accommodations?

The Office Manager will work with you to make transportation and hotel arrangements. If you are attending a workshop, seminar, or conference that requires a fee, he/she also reserves your place and takes care of the payment.

3. 	I need to take computers and equipment with me when I travel, who do I talk to?

It is important to make arrangements for computer equipment well in advance of traveling and as soon as you know what equipment you need for your demonstration, presentation, or event. Currently, the System Administrator maintains the “traveling” hardware, and ensures that it is in good working order after every trip. Speak with the System Administrator about your equipment needs, and he/she will have the equipment ready for you to take, or ship to the site.

4. 	Will there be anyone to help me setup the computers?

It depends on your level of knowledge about the equipment and product, the availability of a technical person, and the size and complexity of the demonstration or event.

5. 	Will I get a corporate credit card to pay for traveling and related expenses?

ILINC provides sales people with a corporate credit card to pay for traveling expenses. Other employees, who travel less frequently, may use a personal credit card and be reimbursed as soon as he/she returns. If that is not feasible, you can request a cash advance to cover most of your expenses prior to traveling.

6. 	What travel expenses does ILINC reimburse me for?

You are reimbursed for lodging, meals ($10 breakfast, $10 lunch, $20 dinner per day), airfare/train fare, car rental, taxi/bus/public transportation, tolls, gas, parking, phone, fax, and other miscellaneous expenses. ILINC also covers the cost of entertaining customers and prospective clients. If you use your own vehicle to travel or run errands for ILINC, you are reimbursed $.30 per mile.

�7. 	How do I get reimbursed for expenses I incur while traveling?

Keep all of your receipts, of course. You can find a hard copy expense report in the storage slots on top of the office supplies cabinet or an electronic version on one of the network drives (L:/Expense.xls). Fill out the report and sign it, make a copy of it and all of your receipts, then submit the original form and receipts to your supervisor. Your supervisor approves the report and passes on the information to the Accountant. Keep copies of everything for your own records. If you travel frequently, submit an expense report after every trip, so the accountant can keep up with everyone’s reimbursements. 

If you need to be reimbursed for expenses incurred at the end of the month, submit your expense report and receipts within the first week of the next month. Submitting expense reports promptly is vital for the Accountant to maintain precise records.

8. 	What responsibilities are mine when traveling for the company? 

ILINC takes care of most arrangements and expenses when you travel on business. However, there are a few items that you need to take care of on your own. If you are traveling abroad, you need to obtain a passport and other identification. 

If you do not have a corporate credit card or a cash advance, be prepared to charge expenses on your personal cards including car rental, hotel, food, fuel, etc. You need cash to cover tolls and parking.

9. 	Can I bring a spouse/friend with me on a business trip?

It depends on the type of event you are attending, your role there, and other variables. This should be discussed with your supervisor on a per-event basis.

�Solving problems

1. 	I have a problem with another employee. How should I address it?

Try to resolve the problem with that person. If you cannot come to an agreement, present the problem to your supervisors. They will attempt to work with you to resolve the issue. If they cannot, they will present the problem to the next level of management, and so on, until it is resolved. 

2. 	I have a conflict with my supervisor. How should I go about resolving it?

As always, you and your supervisor should try to work it out on your own. If your attempts to solve the problem are unsuccessful or if you are uncomfortable confronting your supervisor about the problem, it is acceptable to ask the next level manager to act as a mediator for your discussion.

�Getting through a review 

1. 	How often does a review happen?

Typically, once a year, around the time of your anniversary of joining the company. Some managers choose to perform interim reviews at 3 or 6 months, as well.

2. 	Who will be my reviewer and what is the process?

Your supervisor conducts the review process. Each of you will spend time to evaluate your performance in certain key areas. Next, you meet to discuss your evaluations and how you can continue developing and sharpening your professional skills. A day or two after the review, you and your supervisor will have a follow-up meeting to confirm action items that resulted from your discussion. 

3. 	How long will it take?

It depends on the nature of your work and the depth that your supervisor and yourself go into. The initial evaluation should take only a few hours. Meeting with your supervisor to discuss your evaluations may take a couple hours, or may take an entire afternoon. The follow-up meeting will probably last an hour or less.

4. 	What can I do to prepare for a review?

If you have never been through a review and are nervous, discuss the process with your supervisor ahead of time. Just knowing what to expect will help you feel more at ease.

�Taking personal time

1. 	I need to leave work for an hour. Who do I ask for permission?

Your supervisor. If he/she is not available, the next level manager.

2. 	Who do I tell when I leave work for a personal reason?

You need to tell your supervisor, the kind people taking over any of your responsibilities, and the Office Manager.

3. 	Should I ask someone else to take over my responsibilities while I’m out?

Most definitely. Arrange for a coworker or your supervisor to handle any issues that may arise in your absence. This includes important projects, events, phone calls, visits, and anything else.

4. 	Am I docked for being late or taking personal time?

	Discuss your supervisor’s policy with him/her to avoid being docked.

�Special Section for Sales/Marketing Employees

�Special Section for Developers

�Programming Conventions

The ILINC development team uses the following naming conventions to enhance readability, and to reduce the risk of errors in the software development process.

C++ Identifiers

Guards in header files

Compiler warning level

Copyright notices

�C++ Identifiers

Select the C++ identifiers (including types, functions, and classes) carefully.  When a programmer sees a name, it might be out of context; choose names to enhance readability and comprehension. A name that seems cute or easy to type can cause trouble to someone trying to decipher code.  Remember, code is read many more times than it is written; err on the side of long, readable names.



Identifier�Convention�Example��Types�Begin with a capital letter�Boolean��Base classes�Begin with T�TContainerView��Mixin classes (Multiple inheritance)�Begin with M.  Multiple inheritance is not allowed without the approval of a senior MTS other than yourself�MPrintable��Enumeration types�Begin with E�EFreezeLevel��Raw C Types�Avoid using C types, use typedef or class definitions to abstract the data type (see pg. 40 of Taligent guidebook)���Virtual base classes�Begin with V, rather than T or M�VBaseClass��Members�Begin with f; functions begin with a capital letter�fViewList, DrawSelf()��Static variables�begin with g; applies to static variables in functions and global variables (excluding static data members of a class)�gDeviceList��Static data members�Begin with fg; includes class globals�TView::fgTokenClient��Locals and parameters�Begin with a word whose initial letter is lowercase; local automatic variables only, treat statics like globals�seed, port, theCurrentArea��Constants�Begin with k; including names of enumeration constants and constant statics�kMenuCommand��Acronyms�All uppercase�TDTSServer, not TDtsServer��Template arguments�Begin with A�AType��Getters and setters�Begin with Set..., Get..., or Is... (Boolean); use sparingly (see "structification" on pg. 23 of Taligent Guide)�SetLast(), GetNext(), IsDone()��Allocator and adopters�Begin with Create..., Copy..., Adopt..., or Orphan...; see "Use special names for copy, create, and adopt routines" on pg. 35 of Taligent Guide.�CreateName()��



Guards in header files

TBD

#ifndef ?????// To prevent this file being included more than once

#define ?????



It will be really useful to use a consistent  error code scheme in LearnLinc. We can reserve error code  slots for different pieces of the system.  For example,  errors 6000 to 6500 (or -6000 to -6500) may be reserved for Share Server. Maybe we can also have a PutErrorMessageBox() function in ilincutl.dll. When we want an error message box to be displayed, we can call this function, and our error messages will look consistent throughout the system.

I have to search for valid error ranges that we can use before I can write more on this issue.

What kind of feeling about using namespaces to separate the individual modules we are working on does everyone have? This would allow us to create classes and other type without regard to what others are working on. Also, prefixing classes would go away. For example: floorcontrol::TAttendee would replace TFCAttendee in all client code except the floor controls!



Compiler warning level

To ensure that we get all the compile time error catching we can, we will increase the compiler warning level from 3 to 4.  All pieces of code shall compile without getting any compiler warnings at level 4.

In the rare occasion that the warning is obviously incorrect, we might elect to put a compiler directive to supress the warning - but only after the issue has been discussed by all the members of the coding team and a two-thirds majority vote has been obtained.

The next time you touch a project, please update the warning level.

This is one of the checklist items we will have for product release and interim milestones.



�Copyright notices

To assist in protecting ILINC's intellectual property, include a copyright notice at the front of every file you create:

/////////////////////////////////////////////////////////////////////////////

// Copyright © 1994, 1995 Interactive Learning International, Inc.

//                     All Rights Reserved

/////////////////////////////////////////////////////////////////////////////



If you significantly modify a file, list the year of the modification.  The years correspond to publication, not creation, dates.  Separate consecutive years with a dash, but off-years with a comma:

// Copyright © 1994, 1996-1998 Interactive Learning International, Inc.

(No publication in 1995)



Any binary files we ship also needs to be tagged with copyright information.
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